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Windows Vista Lesson 1:  What is Windows Vista?

Operating systems control the functions performed by a computer. For example, the operating system on your computer controls the input from the keyboard and mouse to your computer, the opening and closing of programs, the transfer of information to a printer, the organization of the files on your computer, and the screen display. To function, every computer must have an operating system. Windows Vista is an operating system. It was released by the Microsoft Corporation in late 2006.

Windows Vista comes in several versions: Home Basic, Home Premium, Business, Ultimate, and Enterprise. The features available to you depend on the version of Windows Vista you have. 

Windows Vista Home Basic is the entry-level edition. Geared toward home computer users, Home Basic has features that allow you to search your computer, search the Web, browse the Internet, view photos, send and retrieve e-mail, and set parental controls. 

Windows Defender and Windows Firewall are included with Windows Vista Home Basic. Windows Defender helps protect your computer from spyware. Spyware is malicious software you install on your computer inadvertently or is put on your computer without your consent. Windows Firewall helps protect your computer from malicious software and unauthorized access to your computer. 

Windows Vista Home Premium has most of the features found in Windows Vista Home Basic plus additional features such as Aero, Windows Media Center, Windows Meeting Space, Windows Mobility Center, Windows SideShow, and Tablet PC support. Windows Aero features translucent windows and smooth animations, including the capability to do three-dimensional flips through open windows. It also provides a thumbnail preview of the contents of open windows when you pause your mouse pointer over the window’s identifier on the taskbar or Alt-Tab through windows. With Windows Media Center, you can record and watch TV shows, listen to Internet and FM radio, view home movies, create slide shows, and burn CDs or DVDs. You can use Windows Meeting Space to set up meetings in which you can share documents, programs, or your desktop with others. Windows Mobility Center provides a convenient location for you to adjust the settings for your mobile PC. With Windows SideShow, you can send information from your computer to other devices such as mobile phones, hand-held computers, and TVs. A tablet PC is a mobile computer that you can interact with by writing on the screen or by using your finger or a pen. You can use Windows Vista Premium with a tablet PC.

What is a desktop?

If you are using Windows Vista, after you start your computer the first thing you see is the desktop. The desktop is your work area. 

Can you explain the Windows Vista desktop?

The following table explains the various features of the Windows Vista desktop.
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PRIVATE "TYPE=PICT;ALT=The Desktop"
Feature 
Explanation 

Taskbar
By default, the taskbar is located on the bottom edge of the desktop. You can click the taskbar and drag it to other locations. The Start button, active program buttons, icons for quick access to programs, and the notification area are located on the taskbar.

Recycle Bin
When you delete an object, Windows Vista sends it to the Recycle Bin. You can restore objects from the Recycle Bin or you can permanently delete them.

Shortcut icon
Icons with an arrow in the lower-left corner are shortcut icons. Click the icon for quick access to the object it represents (program, document, printer, and so on).

Program, folder, and document icons
Program, folder, and document icons do not have an arrow in the lower-left corner. These icons represent the actual objects and provide direct access to the objects. Be careful: When you delete a program, folder, or document icon, you are deleting the actual program, folder, or document. 

Sidebar
The default placement for the Windows Vista sidebar is along the right side of your desktop. You can use the sidebar to display gadgets. Gadgets are small programs with which you can display a clock, post notes, track stocks, or perform other miscellaneous tasks.

Can you explain the taskbar?
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The taskbar is a long bar that by default runs along the bottom of your desktop. The Start button, Quick Launch toolbar, active program buttons, and the notification area are located on the taskbar. 
PRIVATE "TYPE=PICT;ALT=The Taskbar"
1
Start
2
Quick Launch Toolbar

3
Active Program Buttons
4
Notification Area

You click the Start button to display the Start menu. You use the Start menu to open programs and to perform other functions such as searching for files.

On the taskbar, right next to the Start button is the Quick Launch toolbar. Using the Quick Launch toolbar, you can open a program or file simply by clicking its icon. To add an icon to the Quick Launch toolbar:

1. Locate the program you want to add. 

2. Right-click. A context menu appears. 

3. [image: image3.png]


Click Add to Quick Launch. Vista adds the program to the Quick Launch toolbar. 

PRIVATE "TYPE=PICT;ALT=Quick Launch"
1
Show Desktop
2
Switch Between Windows

Two icons appear on the Quick Launch toolbar by default: the Show Desktop icon and the Switch between Windows icon. You can display the desktop by clicking the Show Desktop icon. You can use the Switch between Windows icon to display all open windows in 3D flip if your version of windows has Aero or you can use the Switch between Windows icon to tab through open windows if your version of Vista does not have Aero.
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When using Vista, each program, document, or other type of file opens in its own window. You can have multiple programs, documents, and files open at a given time. A button for each open program, file, or document window displays on the taskbar. You can quickly move from one open file to another open file by clicking the files button. If you have a large number of files open, Vista may group all files of a given type together. For example, if you have several Microsoft Word documents open, Vista may group them together. When you click the button for Microsoft Word, Vista displays a menu of open Word files. You can click the document you want to open.

PRIVATE "TYPE=PICT;ALT=Notification Area"
The notification area is located on the right side of the task bar. It displays several icons and the current time. The icons that display depend on the way in which your computer is configured. You can move your mouse pointer over an icon to see the current settings for the option the icon represents. In many cases, you can click the icon to change the settings. For example, the Volume icon is located in the notification area. When you pause your over the Volume icon the volume setting for the speakers on your computer appears. You can click the icon to adjust the volume.

When I finish working with my computer, what should I do?
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When you finish working with your computer, you should put your computer in sleep mode:

1. Click the Start button. The Start menu appears. 

2. Click the Power button. Vista puts your computer in the sleep mode. 

When you click the Power button, Vista saves all of your work, turns off the display screen, and puts your computer in sleep mode. To indicate that your computer is in sleep mode, some of the lights on your computer may blink and/or change color.

What do you mean when you say my computer is in sleep mode?

In sleep mode, your computer consumes very little electricity. When you need to use your computer again, you can press your computer’s power-on switch to resume work quickly. Instead of shutting your computer down when you are not using your computer, you should put your computer in sleep mode.

I am using a laptop. Won’t putting my computer in sleep mode drain my computer’s battery?

A sleeping computer uses very little energy. Microsoft, the maker of Windows Vista, recommends that you put your computer, whether a desktop or a laptop, in sleep mode when you are not using it. A sleeping computer should not drain your computer’s battery. However, if your power becomes dangerously low, Vista saves your work to your hard drive and then shuts your computer down.

How do I wake up my computer?

To wake up your computer, press your computer’s power-on switch.

Do I ever need to shut down my computer?

Generally, when you are not using your computer, you should put your computer in sleep mode. However, if you are making changes to your computer hardware, such as installing memory or adding a hard drive, you should shut your computer down. You may also need to shut your computer down when you add hardware to your system, such as a new printer.

How do I shut down my computer?PRIVATE "TYPE=PICT;ALT=Shut Down Computer"
1. Click the Start button. The Start menu appears. 

2. Click the arrow in the lower-right corner of the start menu. A menu appears. 

3. [image: image7.png]@ Busioes Computes

et Ooauments




Click Shut Down. Your computer shuts down. 

When you need to restart your computer, press your computer’s power-on switch.

Windows Vista Lesson 2

What is a program?

You use programs, also referred to as software, to perform tasks when using a computer. For example, if you want to use your computer to write a letter, you can use a word-processing program such as Microsoft Word. If you want to keep accounting records, you can use an accounting program such as QuickBooks. 

How do I start a program? 
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PRIVATE "TYPE=PICT;ALT=Frequently Used Programs "
To start a program: 

4. Click the Start button, located in the lower-left corner of your screen. A menu showing the programs you use most frequently appears on the left, and commonly performed tasks appear on the right. 

5. Click the program you want to open. Vista starts the program. 

I do not see the program I want to open. What should I do?

PRIVATE "TYPE=PICT;ALT=Search Box"
After you click the Start button, a search box appears just above it. You can use the search box to locate programs or anything else that is located on your computer, including documents that contain the word you type. Type the name of the program, e-mail, file, or whatever you are looking for in the Search box. Vista searches your computer. The results of the search appear on the Start menu. When you see the program you are looking for, you can click the program name to open the program.

Is there a menu that lists all my programs?

PRIVATE "TYPE=PICT;ALT=All Programs Menu"
3. Click the Start button. The Start menu appears. 

4. Click All Programs. A listing of programs and program folders appears. 

5. Click a program to open a program, or click a folder to open a folder and then click the program name. Vista starts the program. 

Note: You may not be able to view all of your programs on the screen at one time. Click and drag the scroll bar up or down to change which programs are in view.

Can I customize the Start menu?

You can customize the Start menu to suit your personal style. If you right-click the Start menu, a context menu appears (a context menu performs an action related specifically to the object you click). You can click an option on the context menu to perform all of the actions discussed in the next several questions.
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PRIVATE "TYPE=PICT;ALT=Context Menu"
How do I add a program to the first page of the Start menu?

4. Find the program name in the All Programs list. 

5. Right-click the program name. A context menu appears. 

6. Click Pin To Start Menu. The program appears on the first page of the Start menu above the horizontal line. 

How do I remove a program from the first page of the Start menu?

1. Right-click the program name. A context menu appears. 

2. Click Unpin From Start Menu. Vista removes the program from the first page of the Start menu. 

If the program is located below the horizontal line, right-click the program name and then click Remove from This List.

How do I copy an item that is located on the Start menu or the Program menu? 

1. Right-click the item. A context menu appears. 

2. Click Copy. Vista copies the program. 

You can paste the copy to your desktop to create a desktop shortcut.

1. Right-click your desktop. 

2. Click Paste. Vista creates a desktop shortcut. 

How do I rename an item on the Start menu or the Program menu? 

1. Right-click the item. A context menu appears. 

2. Click Rename. Vista highlights the name. 

3. Type the new name. 

4. Press Enter. Vista changes the name. 

How can I quickly locate files and folders? 

You can use the Vista search feature to locate documents, folders, pictures, music, and e-mails that are located on your computer. You can also use the Vista Search feature to locate a document that includes a particular word or phrase. When you click Search on the Start menu, the search window appears. A search field is located in the upper-right corner of the window. In the search field, type the name of the file or folder you are looking for, the date it was last modified, or even the author of the file. As you type, Vista searches for the file. Vista also provides you with a several options to narrow your search. You can click All to search everything, E-mail to search e-mail, Document to search documents, and so on. 

PRIVATE "TYPE=PICT;ALT=Search Dialog Box"
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1. Click the Start button. 

2. Click Search. The Search dialog box appears. 

3. Type the filename, the folder name, the date the file was last modified, or the author of the file in the Search field. As you type, Vista attempts to locate the file. The results of the search appear in the window. You can click the filename to open the file. 
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By default, vista searches indexed locations. Indexed locations are locations that are stored in your Personal folder. To close the Search window, click the X in the upper-right corner.

What does the Advanced search option do?

PRIVATE "TYPE=PICT;ALT=Advanced Search Button"
In the Search Explorer window, you can click the button next to the words Advanced Search to display several options with which you can refine your search. The advanced search option enables you to search by date, location, file size, or property.
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PRIVATE "TYPE=PICT;ALT=Advanced Search "
Field 
Entry Type

Date
Find any file that was created or modified on, before, or after a specified date.

Location
Specify where you want to look. Indexed locations are locations that are stored in your Personal folder. 

Size
Specify that you want to look for files that are above or below a certain size.

Property
Limit your search to files that have a specific name, tag, or author.

To close the Search window, click the X in the upper-right corner.

What is the Most Recently Used Document list? 

As you work, Windows Vista tracks the files and programs you have used. It lists these files and programs on the Most Recently Used Document list. To view the list:

1. Click the Start button. 

2. Click Recent Items on the right side of the Start menu. A list of recent files and programs appears. 

To open a file listed on the Most Recently Used Document list, click the filename. 

How do I set the number of files that display on my Most Recently Used Document list?

1. Right-click the Start button. A context menu appears. 

2. Click Properties. The task bar and Start Menu Properties dialog box appears. 

3. Click the Start Menu tab. 

4. Click Customize. The Customize Start Menu dialog box appears. 

5. Type the number of files you want Vista to display in the Number of Recent Programs to Display field. You can enter any number between 0 and 30. 

6. Click OK. The Customize Start Menu dialog box closes. 

7. Click Apply. 

8. Click OK. Taskbar and Start Menu Properties dialog box closes and Vista resets the number of files that display on the Most Recently Used Document list.

How do I disable my Most Recently Used Document list? 

1. Right-click the Start button. A context menu appears. 

2. Click Properties. The Taskbar and Start Menu Properties dialog box appears. 

3. Click the Start Menu tab. 

4. Deselect Store and Display a List of Recently Opened Files. 

5. Deselect Store and Display a List of Recently Opened Programs. 

6. Click Apply. 

7. Click OK. Vista clears and stops maintaining your most recently used document list. 

Where are the games? 

Several games are included with Windows Vista. To access the games:

1. Click the Start button, which is located in the lower-left corner of the screen. The Start menu appears. 

2. Click Games. The Games Explorer window appears. 

3. Double-click the game you want to play. The game starts.

How do I change the date and/or time that displays on my computer?

You can use the Date and Time dialog box to change both the date and the time your computer displays. 

1. Click the Start button. The Start menu appears. 

2. Click Control panel. The Control Panel appears. 

3. Click Clock, Language, and Region. The Clock, Language, and Region pane appears. 

4. Click Set Time and Date. The Time and Date dialog box appears. 

5. Click Change Date and Time. The User Account Control dialog box may appear, if so click Continue. The Date and Time Settings dialog box appears. 

To change the day of the month:
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PRIVATE "TYPE=PICT;ALT=Change Day"
· Click the day of the month you want. 

To change the month: 
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PRIVATE "TYPE=PICT;ALT=Change Month"
1. Click the month and year. All of the months of the year display. 

2. Click the month you want. Vista changes the month. 
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To change the year:

[image: image18.png].




PRIVATE "TYPE=PICT;ALT=Change Year  "
PRIVATE "TYPE=PICT;ALT=Change Year"
1. Click the month and year. All the months of the year appear. 

2. Click the year. A list of years appears. 

3. Click the year you want. If you do not see the year you want, use the arrow keys on your keybaord to scroll forward or backward through the list. 

4. Click OK. 

How do I change my Time Zone?

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click Clock, Language, and Region. The Clock, Language, and Region dialog box appears. 

4. Click Change the Time Zone. The Date and Time dialog box appears. 

5. Click Change Time Zone. 

6. Click the down-arrow on the Time Zone field and then select the correct time zone. 

7. Click OK. The Time Zone Settings dialog box closes. 

8. Click OK. The Date and Time dialog box closes. Vista changes the time zone on your computer. 

If you want your computer to automatically adjust for daylight savings time, click the Automatically Adjust Clock for Daylight Savings Time checkbox.

How do I install a new printer? 

A USB port is a socket on your computer that allows you to plug devices such as a printer, digital camera, or scanner into your computer. If your printer can be connected to your computer via a usb port, Vista may be able to automatically install your printer. To add a network, Bluetooth, or wireless printer:

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click hardware and Sound. The Hardware and Sound window appears. 

4. Click Add a Printer. The Add Printer Wizard appears. 

5. Click Add a Network, wireless, or Bluetooth. The Add Printer Wizard finds all available printers. 

6. Select the printer you want to install. 

7. Follow the steps outlined by the wizard to complete the installation. 

How do I cancel a print job? 

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click Hardware and Sound. The Hardware and Sound window appears. 

4. Click Printers. The Printers window appears. 

5. Double-click the printer you are using. The printer’s dialog box appears. 

6. Click the job you want to stop. If you want to stop more than one job, hold down the Ctrl key while you click the additional jobs. 

7. Click Document, which is located on the menu bar. A drop-down menu appears. 

8. Click Cancel. You asked if you are sure you want to cancel the print job. 

9. Click Yes. Vista cancels the print job. 

When you start a print job, a print icon may appear on the taskbar in the notification area. You can click the icon to open the printer’s dialog box mention in step 5.

How do I cancel every print job? 

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click Hardware and Sound. The Hardware and Sound window appears. 

4. Click Printers. The Printers window appears. 

5. Double-click the printer you are using. The printer’s window appears. 

6. Click Printer, which is located on the menu bar. 

7. Click Cancel All Documents. The document you are printing may finish, but Windows Vista cancels all other documents. 

How do I temporarily stop selected jobs from printing? 

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click Hardware and Sound. The Hardware and Sound window appears. 

4. Click Printers. The Printers window appears. 

5. Double-click the printer you are using. The printer’s window appears. 

6. Right-click the document you want to pause. A menu appears. 

7. Click Pause Printing. Vista pauses the printing of your document. 

How do I restart print jobs I temporarily stopped?

1. Click the Start button. The Start menu appears. 

2. Click Control Panel. The Control Panel window appears. 

3. Click Hardware and Sound. The Hardware and Sound window appears. 

4. Click Printer. The Printers window appears. 

5. Double-click the printer you are using. The Printer window appears. 

6. Right-click the document that you want to resume printing. A menu appears. 

7. Click Resume. The document starts printing again.

Windows Vista Lesson 3

What is a desktop shortcut? 

A desktop shortcut, usually represented by an icon, is a small file that points to a program, folder, documents, or Internet location. Clicking on a shortcut icon takes you directly to the object to which the shortcut points. Shortcut icons contain a small arrow in their lower-left corner. Shortcuts are merely pointers; deleting a shortcut does not delete the item to which the shortcut points. 

How do I create a desktop shortcut? 

If the item is located on the Start menu: 

6. Click Start. The Start menu appears. 

7. Locate the item to which you want to create a shortcut. If the item is located on a submenu, go to the submenu. 

8. Right-click the item. A context menu appears. 

9. Click Send To. A submenu appears. 

10. Click Desktop (Create Shortcut). Vista creates a shortcut to the item. 

If the item is visible in Windows Explorer: 

6. Open Windows Explorer. 

7. Locate the item for which you want to create a shortcut. 

8. Right-click the item. A context menu appears. 

9. Click Send To. A submenu appears. 

10. Click Desktop (Create Shortcut). Vista creates a shortcut to the item. 

How do I create a desktop shortcut to a web page?
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PRIVATE "TYPE=PICT;ALT=Shortcut to Web Page" 
If you are using Internet explorer:

7. Click the icon that precedes the URL on the address bar. 

8. Drag the icon to your desk top. Vista creates the shortcut. 

Now, when you click on the shortcut, the Web page will open.
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How do I turn a Web link into a desktop shortcut? 

PRIVATE "TYPE=PICT;ALT=Turn a Web Link into a Desktop Shortcut" 
3. Click the link in your browser window (usually underlined text) and drag it to the desktop. An icon appears on your desktop. 

4. Click the icon to go directly to the link’s destination. If your browser is not open, clicking the icon starts the browser. 

How does the Create Shortcut Wizard work? 

You can use the Create Shortcut Wizard to add a shortcut to your desktop. 

3. Right-click the desktop. A context menu appears. 

4. Click New. A submenu appears. 

5. Click Shortcut. The Create Shortcut dialog box appears. 

6. Type in the location of the item to which you want to create a shortcut. Alternatively, browse to find the item. 

7. Click Next. The next Create Shortcut dialog box appears. 

8. Accept the default name or type in a new name. 

9. Click Finish. Vista creates the shortcut. 

How do I rename a desktop shortcut? 

The name of the desktop shortcut displays below its icon. For example, if you create a shortcut to the program Microsoft Word, the name Microsoft Word displays below the icon. To rename a shortcut: 

3. Right-click the shortcut. A context menu appears. 

4. Click Rename. 

5. Type a new name. 

6. Press Enter. Vista renames the icon. 

I have a shortcut that opens a program on my desktop. How do I add it to the Start menu? 

5. Right-click the shortcut icon. A menu appears. 

6. Click Pin To Start menu. The program appears on the Start menu, above the horizontal line. 

How do I change the icon associated with an object on the desktop? 

4. Right-click the icon. The context menu appears. 

5. Click Properties. The Properties dialog box appears. 

6. Click the Change Icon button. The Change Icon dialog box appears. 

7. Click the icon of your choice. 

8. Click OK. The Change Icon dialog box closes. 

9. Click Apply. 

10. Click OK. Vista closes the Properties dialog box. Vista changes the icon. 

Note: Not all icons can be changed. If you do not see the Change Icon button or if the change icon button is dimmed, the icon cannot be changed.

How do I delete a desktop shortcut? 

3. Click the shortcut. 

4. Press the Delete key. Vista asks if you are sure you want to delete the shortcut. 

5. Click Yes. 

Remember, shortcuts have an arrow in the lower-left corner. If the icon you delete does not have an arrow in the lower-left corner, it is not a shortcut and deleting the icon deletes the object.

What is wallpaper? 

Wallpaper is the background that displays on your desktop.
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How do I change my wallpaper?

PRIVATE "TYPE=PICT;ALT=Wallpaper"
9. Click the Start button. 

10. Click Control Panel, which is located on the right side of the Start menu. The Control panel appears. 

11. Click Change the Desktop Background. It is listed under Appearance and Personalization. 

12. Select the wallpaper you want from the ones that appear or click the down-arrow in the picture location field to select another wallpaper category. 

Note: If you would like to display an image you created, you can click Browse to find the image. 
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Click to select how you want your image to appear on the screen. Choose from the following: 

PRIVATE "TYPE=PICT;ALT=Wallpaper Style" 
Option
Explanation
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Center

PRIVATE "TYPE=PICT;ALT=Center"
Place the image in the center of the screen.
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Tile

PRIVATE "TYPE=PICT;ALT=Tile"
Have the image display as tiles across and down the screen.
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Stretch

PRIVATE "TYPE=PICT;ALT=Stretch"
Stretch the image so the image covers the entire screen.

What is a font? 

A font is a set of characters represented in a single typeface. Each character within a font is created by using the same basic style. 

Can you explain font size? 

Fonts are measured in points. There are 72 points to an inch. The number of points assigned to a font is based on the distance from the top to the bottom of its longest character.

Windows Vista Lesson 4
What are drives? 

Drives are hardware components used to store data. Almost all computers come with at least two drives: a hard drive (for storing large volumes of data) and a CD or CD/DVD drive (for storing smaller volumes of data that you can easily transport from one computer to another). The hard drive is typically designated the C:\ drive, and the CD drive is typically designated the D:\ drive. If you have an additional internal drive, it may be designated the A:\ drive. If your hard drive is partitioned (divided into several parts) or if you have additional drives, the letters E:\, F:\, G:\, and so on are assigned. 

What are folders and files? 

Folders are used to organize the data stored on your drives. A file is a collection of related information or a computerized document. The files that make up a program are stored together in their own set of folders. When you create files, a good idea is to organize them in folders and to store files of a like kind in a single folder. Microsoft recommends that you store your documents under the Documents folder, your pictures under the Pictures folder, and your Music under the Music folder.

How does Vista organize files and folders on drives? 
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Vista organizes folders and files in a hierarchical system. The drive is the highest level of the hierarchy. You can put all of your files on a drive without creating any folders, but that is like putting all of your papers in a file cabinet without organizing them into folders. It works fine if you have only a few files, but as the number of files increases, there comes a point at which things are difficult to find. To avoid this, create folders and put related material together in folders. 

A diagram of typical drives and how they are organized is shown here. 

PRIVATE "TYPE=PICT;ALT=Drive Organization" 
At the highest level, you have some folders and perhaps some files. You can open any of the folders and put additional files and folders into them. This creates a hierarchy. 

Will you explain Explorer windows?

You use Explorer windows to search for and manage the files on your computer. When you open your Personal folder or click Documents, Pictures, Music, Games, Computer, or Network on the Start menu, an Explorer window appears. Explorer windows consist of several parts: the Forward and Back buttons, the Address bar, the Instant Search box, the Command bar, the Menu bar, the Navigation pane, the File List, the Headings, the Preview pane, and the Details pane.
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PRIVATE "TYPE=PICT;ALT=Explorer Window" 
No.
Area
No.
Area

1
Forward and Back buttons
2
Address bar

3
Instant Search box
4
Command bar

5
Menu bar
6
Navigation pane

7
File List
8
Headings

9
Preview pane
10
Details pane

Area
Description

Forward and Back Buttons
You can use the Forward and Back buttons to move forward and backward through your searches.

Address Bar
The Address bar provides drop-down menus for the current navigation path. A navigation path is the sequence of folders on a drive that you must open to get to the file for which you are looking. The folders are ordered from the highest to lowest point in the hierarchy. You can use the Address bar to move up or down the navigation path. You can also use the Address bar to find recently visited web sites and prior searches.

Instant Search Box
In the Instant Search box, you can search for folders and files on your computer by typing the folder or filename. You can also use the Search box to find all documents that contain a particular word or phrase or have a specific property. 

Command Bar
By using the Command bar, you can perform a variety of tasks related to managing and organizing the files on your computer. For example, you can use the Command bar to cut, copy, and paste files.

Menu Bar
For the most part, the Menu bar has the same features as the Command bar. By using the Menu bar, you can perform a variety of tasks that relate to managing and organizing the files on your computer. Because the Command bar and the Menu bar perform many of the same functions, by default the Menu bar does not display. To display the Menu bar, press the Alt key.

Navigation Pane
You can use the Navigation pane to open a folder. For easy access, commonly used folders are listed at the top of the Navigation pane.

File List 
When you open a folder, Vista lists the contents of the folder in the File List.

Headings
Headings appear at the top of the File List. Headings identify the file properties.

Preview Pane
For programs that support this feature, the Preview pane shows you the contents of a document without opening the document.

Details Pane
You can use the Details pane to view, add, and/or change a document’s properties. Properties are characteristics that are either automatically assigned to a file or assigned to a file by you. Properties include such things as the date the file was last modified, the author, and the document category. 

Start by opening an Explorer window:

11. Click the Start button. 

12. Click the name of your Personal folder, Documents, Pictures, Music, Games, or Computer. 

13. An Explorer window opens. 

Select the parts you want to display:

11. Click Organize on the Command bar. A menu appears. 

12. Click Layout. A submenu appears. 

13. Click to select all the options you want to appear in the Explorer window. Choose from Menu Bar, Details Pane, Preview Pane, and Navigation Pane. 

Note: Choosing Menu Bar causes the menu to permanently display.

What is a Personal folder?

When you log on to Windows Vista for the first time, you must create an account. Thereafter, you log on to your computer by clicking the account name. After you create an account, Vista creates a Personal folder for you. Vista stores the folders you will use most often, such as the Documents, Pictures, and Music folders, under your Personal folder. Vista gives your Personal folder the same name as your account name. For example, my account name is Denise Etheridge; Vista named my Personal folder Denise Etheridge. Clicking your Personal folder name opens an Explorer window. I will use the Personal folder to illustrate how to use an Explorer window.

How do I open my Personal folder?
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PRIVATE "TYPE=PICT;ALT=Start Personal"
9. Click the Start button. 

10. Click the name you entered when you created your account. The name is located at the top of the Start menu’s right column. 
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PRIVATE "TYPE=PICT;ALT=Personal Folder"
When you open the Personal folder, an Explorer window similar to the one shown here appears. 

How do I open a folder?

To open a folder that is located under the Favorite Links area of the Navigation pane, click the folder name. The contents of the folder appear in the File List.

If the folder you are looking for does not appear under Favorite Links:

5. Click Folders, which is located in the lower-left corner of the Navigation pane. Additional folders appear. The folders are structured in a hierarchy as they were in Windows XP, which is the previous version of the Windows operating system. 

6. Click the folder you want to open. 

To close the Folders area, click the word Folders again. It may have moved to the top of the Navigation pane.

How do I open a file or a folder that is located in the File List?

When you open a folder, the folders and files contained in the folder appear in the File List. To open a file, double click the filename. You can also open the folders that appear in the File List by double-clicking them.

How do I create a new folder? 

To create a new folder: 

10. Locate the folder in which you want to create the new folder. 

11. Click Organize on the Command bar. 

12. Click New Folder. Vista creates a new folder. 

13. Type a name for the folder. 

14. Press Enter. Vista changes the name of the folder. 

Can I search for files and folders?

To search for a file or even for a word that is contained in a file, use the Instant Search box located in the upper-right corner of your Personal folder:

7. Type what you are searching for in the Instant Search box. As you type, Vista displays the results of the search in the File List. 

8. Double-click a filename to open the file. 

Can I save a search?

You can save a search so you can use it again. 

7. Create your search. 

8. Click Save Search. The Save As dialog box appears. 

9. Type the name you want to give your search. 

10. Click Save. Vista saves the search in the Searches folder. 

To run your search again:

11. Click Searches in the Navigation pane. The Searches folder appears. 

12. Double-click the search you want to run. Vista runs the search. 

How does the Address bar work?
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The Address bar is located in the upper-left corner of an Explorer window. You can use the Address bar to navigate through your folders. To open a folder:

PRIVATE "TYPE=PICT;ALT=Address Bar" 
6. Click the arrow next to the folder name. A list of the folders in that folder appears. 

7. Click the folder you want to open. 

You can move up and down the folder hierarchy (path) by clicking folder names.

Can I add folders and saved searches to the Navigation pane?

You can open the folders and execute the searches on the Navigation pane simply by clicking them. If you have a folder or search you access frequently, you may want to add it to the Navigation pane.

14. Locate the folder or search you want to add. 

15. Click and drag the folder or search to the Navigation pane. You can now click the folder name or the search to open the folder. 

If you use a saved search frequently, you can also add the search to the Navigation pane by clicking and dragging.

How do I display the Menu bar?

By default, the Menu bar does not appear. To temporarily display the Menu bar, press the Alt key. To hide the Menu bar, press the Alt key again. You can also choose to display the Menu bar permanently.

8. Click Organize. A menu appears. 

9. Click Layout. A submenu appears. 

10. Click Menu Bar. A check mark appears next to Menu Bar. The check mark indicates Menu Bar is selected. When Menu bar is selected, the menu bar permanently displays. 

Will you explain Explorer views? 

Views control how Explorer Windows display information in the File List. The Views option on the Explorer Command bar provides the following choices: Extra Large icons, Large Icons, Medium icons, Small Icons, List, Details, and Tiles. 

· Tiles view and Icon views display icons to represent drives, folders, and the contents of folders. You can choose from icons that are large, small, or medium in size. 

· List view displays all of the files and folders without displaying the properties. 

· Details view displays the filename and associated properties you have selected to display. 

To change the view: 
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PRIVATE "TYPE=PICT;ALT=Change View" 
4. Click the down-arrow next to Views on the Command bar. A menu appears. 

5. Drag the slider to select the view you want. 

What are file properties?
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File properties are pieces of information that are associated with a file. For example, Vista automatically saves the date and time each time you modify a file. You can also associate properties with a file. For example, you can place all files associated with sales in a category called sales.

PRIVATE "TYPE=PICT;ALT=Properties" 
To see a list of the properties you can assign to a file:

6. Right-click a Heading. A list of properties appears. 

7. Click More if you do not see the property for which you are looking. The Choose Details dialog box appears. 

8. Click to select the properties you want to use. A check mark appears next to selected properties. 

You can search for files by entering the property in the Instant Search box. When you click a filename, the file properties display at the bottom of the Explorer window in the Details pane. To change a property listed in the Details pane:
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PRIVATE "TYPE=PICT;ALT=Properties" 
3. Click in the property’s field. 

4. Type the property you want to assign. 

What is filtering?

[image: image34.png]Click property
by which to
filter.




When you filter a folder, you see only the files that have the property for which you are looking. You can filter by any file property. For example, by using a filter, you can view all the files by selected authors. You can apply multiple filters to a single folder. To filter:

PRIVATE "TYPE=PICT;ALT=Filter" 
5. Click the down-arrow next to a Heading. A context menu appears. 

6. Click the property by which you want to filter. For example, if you want to filter by author, click the author’s name. A check mark next to the filter indicates that the property is selected. Vista only displays the files that have the selected properties. 

7. Click the down-arrow next to another Heading to filter by that Heading and then repeat step 2. 

To remove a filter:

9. Click the down-arrow next to the filtered Heading. 

10. Click to remove the check mark next to each filtered property. 

What is stacking?

To show all the files with a particular property together, you use stacking. For example, you can group all the files by a particular author together. 
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PRIVATE "TYPE=PICT;ALT=Stack"
8. Click the down-arrow next to the property by which you want to stack files. A context menu appears. 

9. Click the Stack option at the bottom of the menu. Vista stacks together all the files that have the same property. 

10. Click the Stack icon. Vista expands the stack so you can see the files. 

What is the purpose of Computer option on the Start menu?

The Computer option enables you to open the Explorer Computer window to view the drives on your computer and manipulate folders and files. The Explorer Computer window works much like the Personal folder. You can cut, copy, paste, rename, and delete folders and files. By selecting the Computer option, you can perform many of the functions you performed by using Windows Explorer in previous versions of the Windows operating system, such as Windows XP. 

To access the Explorer Computer window:

10. Click the Start button. The Start menu appears. 

11. Click Computer. Computer is located on the right side of the menu. Information about your computer becomes available to you. 
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Alternatively, you can open the Explorer Computer Window by holding down the Windows Logo key PRIVATE "TYPE=PICT;ALT=Windows Logo"        while typing e (Windows-e).

[image: image37.bmp]How does the Preview pane work?

If you have a file that was created in a program that supports Preview mode, in Explorer windows you can see the contents of the file without opening the file. To see a preview, click the filename. A preview appears in the Preview pane.

How do I delete a file or folder? 

To delete a file or folder: 

8. Right-click the file or folder you want to delete. A context menu appears. 

9. Click Delete. Vista asks, "Are sure you want to move this file to the Recycle Bin?" 

10. Click Yes. Vista places the file or folder in the Recycle Bin. 

How do I copy a file or folder? 

You can make a copy of a file or folder and place the copy in another location. Placing a file or folder in another location is a two-step process. First you make the copy and then you paste the copy in the new location. When you execute a Copy command, Vista stores the information you copied in a storage area called the Clipboard. Refer to the question “How do I paste a file or folder?” to learn how to paste.

8. Right-click the file or folder you want to copy. A context menu appears. 

9. Click Copy. The file or folder is now on the Clipboard. 

How do I cut a file or folder? 

Cutting enables you to move a file to a new location. Moving a file to a new location is a two-step process. First you remove the file from its current location by cutting it. Then you paste it in the new location. When you execute a Cut command, Vista stores the information you cut in a storage area called the Clipboard. Refer to the question “How do I paste a file or folder?” to learn how to paste.

8. Right-click the file or folder you want to cut. A context menu appears. 

9. Click Cut. The file or folder is now on the Clipboard. 

Note: Cutting differs from deleting. When you cut a file, the file is placed on the Clipboard. When you delete a file, the file is sent to the Recycle Bin. 

How do I paste a file or folder? 

Pasting places information on the Clipboard in the location you specify. To paste a file or folder: 

1. After copying or cutting the file, right-click in the File list to which you want to paste. A context menu appears. 

2. Click Paste. Vista pastes the file in the new location. 

How do I rename a file or folder? 

1. Right-click the file or folder. A context menu appears. 

2. Click Rename. 

3. Type the new name. 

4. Press Enter. Vista changes the name of the file or folder. 

What is a screen saver? 

Computer monitors display images by firing electron beams at a phosphor-coated screen. If the same image stays on the screen too long, the image may leave a permanent imprint on the screen. Screen savers help prevent this by providing a constantly changing image. 

How do I select a screen saver? 

1. Right-click anywhere on the Windows desktop. A context menu appears. 

2. Click Personalize. The Personalize window appears. 

3. Click Screen Saver. The Screen Saver Settings dialog box appears. 

4. Click the down-arrow in the Screen Saver field. A list of screen savers appears. 

5. Click to select the screen saver you want to use. A preview of the screen saver appears in the Screen Saver Setting dialog box. 

6. In the Wait field, set the number of minutes of inactivity before the screen saver starts. 

7. Click Apply. 

8. Click OK. Vista sets your screen saver. 

Window Vista Lesson 5

What is a window? 

A window is an area on your desktop within which a Windows-based program runs. 

Will you explain the parts of a window? 

I will use WordPad as an example. WordPad is a word-processing program that comes with Windows Vista. To access WordPad:

14. Click the Start button. The Start menu appears. 

15. Click All Programs. The All Programs menu appears. 

16. Click Accessories. The Accessories submenu appears. 

17. Click WordPad. WordPad starts. 
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PRIVATE "TYPE=PICT;ALT=Window"
PRIVATE "TYPE=PICT;ALT=Restore"
No
Area
No
Area

1
Control box
2
Menu bar

3
Title bar
4
Minimize

5
Maximize
6
Close button

7
Command bar
8
Border

9
Status bar
10
Work area

Part
Description

Control box
Provides a menu that enables you to restore, move, size, minimize, maximize, or close a window.

Menu bar
Displays the program’s menu. You can use the menu to send commands to the program.

Title bar
Displays the name of the current file and the name of the current program.

Toolbar
Displays icons you can click to send commands to the program. Toolbars generally appear directly below the menu, but you can drag them and display them along any of the window borders.

Minimize button
Click to temporarily decrease the size of a window or remove a window from view. While a window is minimized, its title appears on the taskbar.

Maximize button
Click to make the window fill the screen.

Close button
Click to exit a window or close a program.

Command bar
Displays icons you can click to send commands to the program.

Border
Separates the window from the desktop. Drag a window’s borders outward to expand it and inward to contract it.

Status bar
Provides information about the status of your program.

Restore button
Click to restore a minimized window to its former size.

Can I have more than one window open at a time? 

You can have as many windows as you want open at the same time. 

How do I switch between windows? 

If you have several windows open at the same time, the window on top is the window with focus. You can only interact with the window with focus. To change windows, do any one of the following: 

· Click anywhere on a window to change the focus to that window. 

· Hold down the Alt key and press the Tab key (Alt-Tab). A preview of all open windows appears. While holding down the Alt key, click the Tab key until you have selected the window to which you want to change. 

· All active files display on the taskbar. Click the taskbar button for the window you want to have focus. 

How do I move a window around on my desktop? 

Left-click the window’s title bar and drag the window. 

What does it mean to "cascade your windows"? 

Cascading is a way of organizing windows on your desktop. Cascading windows fan out across your desktop, with the title bar of each window showing. 

How do I cascade my windows? 

14. Right-click the taskbar. A menu appears. 

15. Click Cascade Windows. 

16. Vista cascades the open windows.

What does it mean to "stack your windows"? 

Stacking is a way of organizing your windows on your desktop. When you stack your windows, Windows Vista places each window on the desktop in such a way that no window overlaps any other window. The windows are stacked one on top of the other. 

How do I stack my windows? 

11. Right-click the taskbar. A menu appears. 

12. Click Show Windows Stacked. Vista stacks your windows. 

What does it mean to "show windows side by side"? 

Showing your windows side by side is another way of organizing your windows on your desktop. When you show your windows side by side, Windows Vista places each window on the desktop in such a way that no window overlaps any other window. The windows display side by side. 

How do I show my windows side by side? 

7. Right-click the taskbar. A menu appears. 

8. Click Show Windows Side by Side. Vista displays your windows side-by-side. 

What are scrollbars? 

In many programs, if the contents of the work area do not fit in the window, scrollbars appear. A vertical scrollbar appears at the right side of the window and a horizontal scrollbar at the bottom of the window. The vertical scrollbar provides a way to move up and down. The horizontal scrollbar provides a way to move from left to right and from right to left. 

The scroll box indicates where you are in your document. If the scroll box is at the top of the scrollbar, you are at the top of the document. If the scroll box is in the center of the scrollbar, you are in the center of the document. 

How do the scrollbars work? 

To move up and down one line at a time: 

· Click the arrow at either end of the vertical scrollbar. 

To move from side to side: 

· Click the arrow at either end of the horizontal scrollbar. 

To move approximately one window at a time: 

· Click above the scroll box to move up. 

· Click below the scroll box to move down. 

To scroll continuously: 

· Click the appropriate arrow and hold down the mouse button. 

To move to a specific location: 

· Left-click the scrollbar and hold down the left mouse button until you arrive at the location. For example, if you want to go to the center of the document, click the center of the scrollbar and hold down the left mouse button. 

· Or, drag the scroll box until you arrive at the desired location. 

What is an icon? 

An icon is a small image. Icons help you execute commands quickly. Commands tell the computer what you want the computer to do. To execute a command by using an icon, click the icon. 

What is a menu? 

Menus provide a way for you to send commands to the computer (tell the computer what you want the computer to do). When you open a window, menu options are listed from left to right on the menu bar, just below the title bar. When you click a menu item, a drop-down menu appears. Select the command you want to execute from the drop-down menu. An ellipsis after a drop-down menu item signifies that there are additional options; if you select that option, a dialog box appears. 

What is a shortcut key?

You can use shortcut keys to execute a command quickly by pressing key combinations instead of selecting the commands directly from the menu or clicking on an icon. When you look at a menu, most of the options have one letter underlined. You can select a menu option by holding down the Alt key and pressing the underlined letter. You can also make Alt-key selections from drop-down menus and dialog boxes. 

In this tutorial and on this Web site, we use the following notation: a key name followed by a hyphen and a letter means to hold down the key while pressing the letter. For example, "Alt-f" means to hold down the Alt key while pressing "f" (this opens the File menu in many programs). As another example, holding down the Ctrl key while pressing "b" (Ctrl-b) bolds selected text in many programs. In some programs, you can assign your own shortcut keys. 

What is a selection? 

A selection is a highlighted area on which you can perform a command. For example, if you are using a word-processing program, you can highlight a word and then execute the Underline command to underline the highlighted word. 

How do I make a selection? 

15. Left-click where you want to start your selection. 

16. Hold down your left mouse button and drag the mouse until you have highlighted the area you want. 

Or 

9. Left-click where you want to start your selection. 

10. Hold down the shift key while you use the arrow keys to highlight the area you want. 

Note: Typing over highlighted text replaces the old text with the new text you type. 

Can you explain cut, copy, and paste? 

The Cut, Copy, and Paste commands are used by almost every Windows program and perform more or less the same function in each of them. You can cut, copy, and paste programs, disks, and text, to name just a few things. 

Cut: When you cut something, you delete it from its current location and save it to the Clipboard. Information saved to the Clipboard stays there until new information is either cut or copied. Each time you execute Cut or Copy, you replace the old information on the Clipboard with whatever you just cut or copied. While information is on the Clipboard you can paste it as often as you like. 

Copy: Copy is similar to Cut except you do not delete the original item. When you copy something, a copy of the item is saved to the Clipboard. Information stored on the Clipboard stays there until new information is either cut or copied. Each time you execute Cut or Copy, you replace the old information on the Clipboard with whatever you just cut or copied. While information is on the Clipboard you can paste it as often as you like.

Paste: You can place Clipboard information wherever you like. When you execute the Paste command, you place the information you have cut or copied wherever your cursor is located. 

Clipboard: The Clipboard is the storage area for items you have cut or copied. Each time you execute Cut or Copy, you replace the old information on the Clipboard with whatever you just cut or copied. You can paste Clipboard information as often as you like, until you replace it with something else. 

There are three major methods of cutting, copying, and pasting: using the menu, using keyboard shortcuts, and using icons. In most programs, they work exactly as described here. 

Using the Menu: 

Cut 

11. Select what you want to cut. 

12. Click Edit, which is located on the menu bar. A drop-down menu appears. 

13. Click Cut. 

Paste 

13. Place the cursor at the point where you want to place the information that is currently on the Clipboard. 

14. Click Edit. A drop-down menu appears. 

15. Click Paste. 

Copy 

8. Select what you want to copy. 

9. Click Edit, which is located on the menu bar. A drop-down menu appears. 

10. Click Copy. 

Using Keyboard Shortcuts: 

Cut 

16. Select what you want to cut. 

17. Press Ctrl-x. 

Paste 

11. Place the cursor at the point where you want to place the information that is currently on the Clipboard. 

12. Press Ctrl-v. 

Copy 

6. Select what you want to copy. 

7. Press Ctrl-c. 

Using Icons: 

Cut 

9. Select what you want to cut. 

10. [image: image40.bmp]Click the Cut PRIVATE "TYPE=PICT;ALT=Cut"icon. 

Paste 

5. Place the cursor at the point where you want to place the information that is currently on the Clipboard. 

6. [image: image41.bmp]Click the Paste PRIVATE "TYPE=PICT;ALT=Paste"icon. 

Copy 

8. Select what you want to copy. 

9. [image: image42.bmp]Click the Copy PRIVATE "TYPE=PICT;ALT=Copy"icon. 

Are there any universals that apply to almost all programs?

Following is a list of commands that appear in many, but not all programs. Check each program's documentation for information specific to the program.

Note: I use the following convention to indicate a menu path: View > Toolbars. When you see View > Toolbars, it means choose View from the menu bar and select Toolbars from the drop-down menu.

Icon
Shortcut Key
Menu Path
Command Description

[image: image43.bmp]PRIVATE "TYPE=PICT;ALT=New"

Ctrl-n
File > New
Create a new file.

[image: image44.bmp]PRIVATE "TYPE=PICT;ALT=Open"
Ctrl-o
File > Open
Open an existing file.



[image: image45.bmp]
PRIVATE "TYPE=PICT;ALT=Save"
Ctrl-s
File > Save
Save the current file.

[image: image46.bmp]
PRIVATE "TYPE=PICT;ALT=Print"
Ctrl-p
File > Print
Print the current file.

[image: image47.bmp]
PRIVATE "TYPE=PICT;ALT=Find"
Ctrl-f
Edit > Find
Find text in the current document.

[image: image48.bmp]PRIVATE "TYPE=PICT;ALT=Cut"
Ctrl-x
Edit > Cut
Cut (delete and place on Clipboard) the current selection.

[image: image49.bmp]PRIVATE "TYPE=PICT;ALT=Paste"
Ctrl-v
Edit > Paste
Place the material currently on the Clipboard at the current location of your cursor.

[image: image50.bmp]PRIVATE "TYPE=PICT;ALT=Copy"
Ctrl-c
Edit > Copy
Copy the current selection to the Clipboard.

[image: image51.bmp]PRIVATE "TYPE=PICT;ALT=Undo"
Ctrl-z
Edit > Undo
Reverse the most recent command. Place the program in the state it was in before executing the last command.

[image: image52.bmp]PRIVATE "TYPE=PICT;ALT=Redo"
Ctrl-y
Edit > Redo
Reverse the last undo. Place the program in the state it was in before executing Undo.

[image: image53.bmp]
PRIVATE "TYPE=PICT;ALT=Font"

Format > Font


Apply a font to the current selection.

[image: image54.bmp]
PRIVATE "TYPE=PICT;ALT=Bold"
Ctrl-b
Format > Font
Bold the current selection.

[image: image55.bmp]PRIVATE "TYPE=PICT;ALT=Italic"

Ctrl-i
Format > Font
Italicize the current selection.

Icon
Shortcut Key
Menu Path
Command Description

[image: image56.bmp]
PRIVATE "TYPE=PICT;ALT=Left Align"
Ctrl-l

Left-align the selection.
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PRIVATE "TYPE=PICT;ALT=Right Align"
Ctrl-r

Right-align the selection.
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PRIVATE "TYPE=PICT;ALT=Center"
Ctrl-e

Center the selection.

[image: image59.png]



PRIVATE "TYPE=PICT;ALT=Justify"
Ctrl-j

Justify the selection.



View > Toolbars
Select the toolbars you want to display.

Will you explain how to save a file?

I will use WordPad as an example. 

11. Click File, which is located on the menu bar. A drop-down menu appears. 

12. Click Save. If you have never saved the file before, the Save As dialog box appears. 

13. Click the down-arrow in the Save As Type field and then select the file type you want your file to have. 

14. Type the name you want to give your file in the File Name field. 

15. Click the Browse button and then use the Explorer window to change folders if needed. 

16. Click the Save button. 
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PRIVATE "TYPE=PICT;ALT=Save File"
Field/Icon
Entry

Address bar
Select the folder to which you want to save the file.

Instant Search box
Search for folders and files on your computer by typing the filename here.

File Name field
Name your file by typing the name in this field.

Save As Type field
Click to open the drop-down box and select a file type.

Browse Folders button
Click to open an Explorer window in which you can perform all of the Explorer functions.

Save button
Click to save your file.

Cancel button
Click if you change your mind and do not wish to save your file.

What is a dialog box? 

Whenever you see an ellipsis (…) after a menu option, selecting that option causes a dialog box to appear. You use dialog boxes to send commands to the computer. Most dialog boxes provide an OK button and a Cancel button. Click the OK button if you are satisfied with your entries and you want to send the commands to the computer. Click the Cancel button if you change your mind and do not want to send the commands to the computer. 

[image: image61.png]] Save A2
es

Text Document ()
Text Document - MS-DOS Format (-0
Unicode Text Document (:tx)




What are tabs? 

PRIVATE "TYPE=PICT;ALT=Tabs"
Some programs provide dialog boxes with several pages of options. You move to a page by clicking on its tab or by using Ctrl-Tab (hold down the Ctrl key while pressing the Tab key to flip through the pages). 
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What are fields? 

PRIVATE "TYPE=PICT;ALT=Fields"
You type entries into fields (also referred to as text boxes). For example, in the Save As dialog box, you type the name you want your file to have in the File Name field. 

What are list boxes? 

PRIVATE "TYPE=PICT;ALT=List Box"

List boxes provide multiple options from which you can choose. To make your selection, simply click the option you want. In some list boxes, you can choose more than one item. To choose multiple items, hold down the Ctrl key while you make your selections. If there are more options than can be displayed in the box, a scrollbar appears on the list box. Use the scrollbar to view the additional choices. 

What is a drop-down or pull-down menu? 

PRIVATE "TYPE=PICT;ALT=Drop-down Menu"

Fields with a drop-down menu have a small downward-pointing arrow next to them. You click the arrow and a list of options appears. You select the option you want from the list. You can also open the drop-down menu by holding down the Alt key and pressing the down-arrow. 

You can use the arrow keys to move up and down in a drop-down menu. You can also move to an item by typing the first few letters of the option.

What are radio buttons? 

PRIVATE "TYPE=PICT;ALT=Radio Buttons"

Windows Vista and programs that run under Windows Vista use radio buttons to present a list of mutually exclusive options. You can select only one of the options presented. Radio buttons are usually round. A dot in the middle indicates that the option is selected. 

What are checkboxes? 

PRIVATE "TYPE=PICT;ALT=Check Boxes"

Checkboxes are another method for selecting options. You click the checkbox to select the item. An X or a check mark appears in a selected box. You toggle checkboxes on and off by clicking in the box. 
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What is a slider? 

PRIVATE "TYPE=PICT;ALT=Slider"
You use a slider to increase or decrease a value. In the illustration, you increase a value by moving the slider toward the right; you decrease a value by moving the slider toward the left. 

What is a spinner? 

PRIVATE "TYPE=PICT;ALT=Spinner"
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A spinner is a set of arrows located on the side of a text box. You use the up-arrow to increment a value and the down-arrow to decrement a value. You can also type the value you want directly into the text box.

Will you explain the Windows Vista color box? 

PRIVATE "TYPE=PICT;ALT=Color Box"
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Some programs allow you to adjust colors; for example, you can adjust the color of text in some programs. The Windows color box provides 48 basic colors. You select a color by clicking on that color’s square. You can save 16 custom colors. To create a custom color, expand the window by clicking on the Define Custom Color button. A color matrix box and a luminosity slider appear. Move the pointer in the color matrix box horizontally to adjust the hue. Move the pointer vertically to adjust the saturation. Use the luminosity slider to adjust the luminosity. The Hue, Saturation, Luminosity (HSL) values and Red, Green, Blue (RGB) values display at the bottom of the window. After you select a color, you can add the color to a Custom Color square by clicking the Add To Custom Colors button. 
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